






























































































































































SHUTTING 
DowN 

Shutting down is the process of the compmer tying up 
all the loose ends inside itse lf and parking the hard disk 
before it's turned off. You can turn it off without shuuing 
down, but it's not recommended. 

When you 're done with the Macintosh, it's good house­
keeping to close up all your windows on the desktop. If 
you have System 6.0 or above you can press Command­
Option-Wand all the windows will fly away home (make 
sure the Caps Lock key is no t down). If you have an 
earlier System version , then hold down the Option key 
while you close the active window; all the rest wi ll fo llow. 

Once all the windows arc closed, from the Special 
men u ch oose "Shut Down." All your disks wi ll pop out 
and you' ll ge t a reassuring dialog box te lling you that 
you can now turn off your computer safely. 

Turn it off with the same button you turned it on, and 
away you go! On any of the Mac lis, "Shut Down" wi ll 
also automatically turn off the computer. 

CHAPTER NINETEEN 

ShuHing Down 

Good 
Housekeeping 
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DESK 
AccEssoRIES 

Desk accessories (DAs) are handy little tools found 
in your menu under the Apple, desig ned to make life 
easie r. Access them like any other menu item-slide 
down the list until it's high lighted, then let go. They're 
a ll windows, so they can be moved around the screen 
from their title bars and closed with the ir little close 
boxes. They all work from with in the System, so you 
can open any of them while you are in any application. 

You can buy an amazing number of desk accessories, 
many for very low prices. They do all manner of useful 
and useless things. This list explains just the ones that 
come standard with any Mac. 

The Alarm Clock won ' t wake you up in the morning, 
but it will beep a t you while you ' re sitting at your com­
puter. After it beeps once, the apple in the corner flashes 
o n and off; on the newer systems it flashes from an apple 
to an alarm clock. T he problem with this alarm is that it 
doesn't turn itself off- even if you turn orr the compute r 
and come back next week, the ala rm clock is still flash­
ing; you have to go get it and turn it off yourself. 

When the clock is the active window on your screen , you 
can press Command- C and create a copy of the date 
and time; set your insertion point d own anywhere, even 
under an icon at your desktop, and press Command-V; 
tl1e date and time wi ll paste into your document, like so: 
1:38:07 AM 7/ 5/ 90. 
0 To change the settings, begin by clicking o n the tiny 

fl ag on the r ight; it wi ll open up to a little conu·ol 
panel. After changing a setting, click anywhere in the 
clock window to put it in to effect. 

0 To change the time: 
• Click on the time clock icon on the bottom left; 

• Click on the number in the middle panel that you 
wish to change (this will cause little up and down 
arrows to appear on the rig ht); 

• Clicking o n th e arrows will move the time forward 
or backward or 

• You can t)'pe in the numbers o nce you select them, 
either from the keyboard or the keypad; 

CHAPTER TWENTY 

Desk Accessories 

Alarm Clock 
I 0 2:02:10 PM~ 
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DEsK AccEssoRIES 

A1rowJ with which to 
change the numbers 

The switch to I!Lm 
the alann on 01· off 

• Change A~! or P.\1 notation the same way. 

• Note: you can p ress the Tab key to move the 
selection from hours to minutes to seconds, e tc. 

0 To change the date: 

• Do the same as for the time, after clicking on the 
little calendar icon . 

0 To set the alarm: 
• Click on the alarm clock icon; 

• Change th e time to whe n you want it to go off, as 
detailed above (check the AM or PM no ta tion); 

• Click the little switch on the left to the up position 
(you' ll notice the zingers around the icon now); 

• When the alarm goes off, you' ll get a beep and/ o r 
your menu will flash, and the li ttle appl e in the 
menu will flash on and off. 

0 To close up the clock: 

• To just get rid of the control panel, cl ick on the flag 
in the upper right again ; 

• To put it away altogether, click in its close box. 
0 To turn off the alarm: 

• To turn it off temporaril)', but leave the a larm set for 
the next day at the same time, simply get the alarm 
clock and then click in its close box. 

• To turn it o ff permanently, you must go in and 
reverse the process of turning it on; that is, click 
on the alarm clock icon and turn off the switch . 

Calculator T he Calculator is a very handy item lO have. It operates 

78 

Calculator · just li ke your hand-held calculator, altho ugh it has only 
~mmam:mi) · the fo ur basic functions. Remember, it's a window so it 

can be dragged around like any other window and put 
away with its close box. Access it in any application. 

• Operate it with the mouse, keyboard, or keypad. 
• If using the keyboard, make sure you use the real 

numeral 1 (one) and not a lowercase I (el). 

• The division sign is the slash: / ; the multipl ication 
sign is the asterisk: * 

• The answer can be copied and pasted into your 
document using using standard methods; you don ' t 
need to se lect the calculator info first-if it's the 
active window, the Copy command knows what to 
copy. You can also copy numbers from your docu­
ment and paste them into the Calculator. 



DEsK AccEssoRIES 

The Chooser is where you choose which printe r you want Chooser 
to print to. If you are working fro m a hard disk ~~~~~~'"~··~··~· ~~~i!!!~ lr I St1tc l o pn nttr port 

either at home or at work and are hooked up to A ~ I [;Q;] 
only one pr in ter, or if you always use the same lliB!IIIIZI '"w•.-~ • 
System disk in the same computer, you need to . 
do this only the very fi rst time you print to that 
printer. 

0 Choose the icon for your printe r: 
• In the left-hand box are the icons for the prin ters 

whose icons are in your System Fo lder; 

• Click on the icon of the prin ter you are going to 
print to (in th is example it's the ImageWriter). 

0 Click on the name or the por t icon of your printer: 

• Depending on which prin ter icon you choose on 
the left, in the right-hand box you' ll see e ithe r 
names of the printers available, or port icons (the 
port icons are asking to which port, or plug o n the 
back of the Mac, your printe r is hooked); in th e 
example you see the choice of a printer port or a 
modem port (here the modem port is chosen, as 
the Lase1Writer is plugged into the printer port). 

0 Adjust the network option (a network lets more 
than one computer talk to the same printer; in this 
example it's Apple Talk): 

• If yours is the o nly Mac hooked up to an Image­
Writer, then AppleTalk will most likely be inactive; 
if several computers are sharing the same printer 
or if you are connected to a LaserWrite r, then 
AppleTalk should be active. 

0 If you type your name, you wi ll then have the pleasure 
of seeing your name on the screen . 

0 Click the close box and con tinue to p rint. 

The Control Panel allows you to customize the 
Mac to your own specific preferences, such as what 
kind of sound to make and how loud it is, how fast 
the insertion poin t flashes, the patte rn of your 
Desktop, e tc. What your particular Control Panel 
has in it depends on what system you are using 
and what is inside your System Fo lder. 

Many of the items are self-explanatory-j ust click 
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DESK AccEssoRIES 

Click here to vinu 
patterns 1 1 

D ::::::: 
Desktop Pattern 

Click here to 
change your screen 

on the radio buttons or on the numbers or on the words in 
a scroll box to alter things to your fancy. Here are a few 
specifics for areas that may not be so obvious: 

0 Desktop Pattern 
• On the "Desktop Pattern" click on the tiny right 

and left arrows-this will take you through a variety 
of patterns; when you like one, click on the pattern 
under the arrows and your desktop will change; 
when you find the blank pa ttern, draw in it with 
the mouse to create your own-clicking on a white 
pixel turns it black; clicking on a black pixel turns 
it white, "erasing" it All patterns can be edited. 

· 0 Clock & Calendar 
• Setting the time and date he re will change the 

Alarm Clock desk accessory also, and vice-versa. 

11!!!!!!11 · 0 Keyboard 

Kf\1 Rf'put Ratt 

000®0 
S\o_. Fu: t 

7-
6 -
5-
4-
3-
2- t 

~-
Speaker 
Volume 
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d$¥111 
C>.l~ Unhl RtfM'~t I 
0 0®00 
Off Lor.o Short 

• Every key on the Macintosh keyboard will repeat, 
meaning if you hold the key down it will continue 
typing that character across the page. With the Key 
Repeat Rate panel you can control how fast it types 
that character across the screen. 

• With the Delay Until Repeat you can turn of! that 
function, so the keys wi ll not repeat when you press. 

• Long to Short is giving you control over how long 
you can hold your finger on a key before it starts to 
repeat. This is wonderful for people who are heavy 
on the keys- set it for a long de lay so if your fingers 
dawdle on the keys you won' t end up wi th extra 
characters all over the place. 

· 0 Sound 

Alert Sound Setting 

Boing 
Clink-Klank 
Monkey 

• J ust click on one of the sounds in the list box on the 

~ 

10 

right and you'll hear it at the level that 
you set your volume control. Whichever 
sound you choose last will be th e one you 
hear whenever Mac wants to beep at you. 
If you don ' t want to hear any sound, set 
the speaker volume to zero- your menu 
will flash instead. 



0 Mouse 
• The slower you set your mouse tracking spfed , with 

Tablet being the slowest, the far ther you have to 
move the mouse in connection with its response on 
the screen. In other words, if you have a ve ry small 
space for your mouse to move around in, then set 
this to the fastest speed-the pointer will move 
farther on the screen with the minimal amount of 
movement on the mouse pad. 

This is a most wonderful tool. There is a little man in 

c:> Hard Dlst 

Search ror. I resume 

" 0 Ru,.,... 

0fWit 1RtNM 

DESK AccESSORIES 

... '""\ 
l=n Click on this icon 
l!!!J to get to its controls 

0!1! 

(T.Citt) (r-b.df) 

0 000 ® 
v.,.,. Slow S'lov r.ut 

• • • • o • ® • o 
Do1A1 it·Cldc $pHd 

Find File 
rind rue 

• loo 

Find File who will find you anything you 
want, even if you have no idea where it is 
or exactly the name of it. It may be in a 
folde r which is in a folde r which is in a 
folder which is in a folder. Well , this guy 
will go get it-he'll look in every folder on 
your hard drive ar only in the folder or 
disk of your choice. He won'tlook in your 

c. .. ,,. . ,,,, ... \9, ,,.., • tt"" ~~ Wo"' Somptes 
Modin.d: "'" · .11u9 26, t98', 1 ., .v1 eg Work s 
Sit• : ~_::;~,k est Progr~:~ms 

~ Herd Disk 

refrigerator or under the sink. 
He'll no t only find your file, but if you ask 
will put it on the Desktop for you . Then wh 

him nicely he 
en you' re all 

through and don 't remember where it came from, j ust 
call him up and he will come right over and put it away 
for you , righ t back where it came from. What a guy. 

0 To locate a file: 
• the insertion point is flashing; you need to type in 

at least three le tters of the fil e name you want 
(actually, he will look even if you only give him one 
le tter , but if there are too many files with that le tter 
in it he gets mad and te lls you to be more specific); 

• if necessary, click on the name of the disk in the 
upper left to have him search another drive ; 

• click on the little man or press Re turn; 

• you can te ll him to stop looking at any time by 
clicking on the Stop sign with the hand on it; 

• the names of any files with those consecutive letters 
in it will show u p just below; 

• click on the name of the file you want and in the 
bottom right he will tell you exactly where ~tis 
located . Make a note ofwhere it is. If the scroll bar 
turns grey, press the ar row to see more. 

0 Put the file on the Desktop: 
• you can now either close Find File and go get your 

The particular file 
selected here 
is in a older called fi 
Works Samples, 
which is in a folder 
called Worlls, 
which is in a folder 
called Programs, 
which is on the 
Hard Disk. 
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file, or go up to the menu bar-notice you have a 
new item: Find File; 

• if you choose "Move to Desktop ... " from that new 
menu , the little man gets the fi le for you and puts it 
on the Desktop . 

. 0 Put the file away: 
• later, at your Desktop, when you want to put that 

particular fi le away and you don't remember where 
it came from, select it (by clicking once on it) and 
choose "Put Away" from the File menu; the li ttle 
man wi ll come and get it and put it away for you. 

· 0 From inside an application: 
• if you 're working on a job inside a program, then 

pull down Find File and enter a name in the box; 
• after he makes the list for you , click on the name 

of the fi le you want; 

• close the Find File window; 

• now when you go to the File menu in your applica­
tio n to Open a document, the one the li ttle man 
found for you will be waiting! 

Key Caps • If the icon Key Layout is in your System Folder, then Key 
• Caps can show you the keyboard layout for every fon t in 

DIIJ[ · your System. On a Macintosh keyboard you actually have 
llCJIC]( : fo ur separate sets of keys, two of which you know already 

Key Layout • and two of which o nly a few people know about. You are 

This is the icon that must • about to become In The Know. 

be in your System Folder • 
in order to view the 

sfJerial characters. • 

• afte r you open up Key Caps, you have a new menu 
item on the far right: Key Caps; 

• pull down the Key Caps menu-this is a list of the 
fon ts that are installed o n your System; 

• select the font you want; the characters of tha t 
font will appear o n th e keyboard (tl1ese are the 
characters everybody knows about); 

• to see the Shift characters, press the Shift key 
(everybody knows these, too); 

• to see the Option characters, press the Option key 
(Ha! You are now In The Know); 

• to sec the Shift- Option characters, press the Sh ift 
and Option keys simultaneously. 

• Different fon ts have different characte rs in the other two 
: keyboards-some have more, some have less. Most of the 
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Option key characters are consistent in every fo nt, so 
you can always fi nd, for instance , the accent manks or 
copyright, trademark, and monetary symbols, etc., in 
the same place. 

Key Caps is only for find ing the placement of all the avail­
able characte rs on the keyboard. Hold down the Option 
key, for instance, and see where the ¢. sign is located. 
O nce you discover that it is found under the 4 (the$ 

. Use Key Caps for 

. finding characters 

sign , logically), then you can go back to your document 
and press Option and 4; the ¢.will appear. It's exactly the • 
same idea as pressing Shift- S to get an asterisk! . 
It's possible to type the characters on the Key Caps • Copy & Paste 
keyboard, copy them (select the characters ftrst, then 
choose Copy from the Edit menu), an d then Paste them 
into your document (they will paste in wherever the 
insertion point is flashing). T his works fin e as lo ng as the • 
font you are using in your document is the same font you • 
chose from Key Caps, or at least that they share the same • 
character. Otherwise when you paste it in it will take on 
the fmmat (type font, size, style) of the characte r to the 
le ft of the insertion point, which may not be what you 
want at all. 

• At the Key Caps keyboard, find the character you 
want to use; 

• remember wha t font and what keys to press lO get 
that character; 

• go back to your document, select the font you want, • 
and press the appropriate keys; 

• can you find the apple? 

, •• 
Also see pages 46-4 7 fo r more info. 

The Note Pad is a nice li ttle feature that allows you to Note Pad 
write up to eight pages of notes. T his is a great place to • ~~Note Pod--

leave prearranged messages, notes about particular • ~·~~Y: ,~~: ~~~~t:~ li re 

formatting used in a document, reminders, or more love • 1 Yourotl1tuoe •syour llre 
2 Nox1m1ze your opu ons 

notes. T hey are automatically saved (they will not be 3 Never toke onyth•ng too 
sen ous ly 

destroyed on rebuilding the Desktop, as Get Info notes • Creol1ng memories ro rour 
Chllaren 

Will, p. 29) • o Every home sttou\0 hove o 
stoge and dance floor. 

T he insertion point is flashing; type into it just as you 
I • f.o-

type anywhere else in the Macintosh. You can backspace/ • 1"1 
delete, cut, copy, paste , e tc. T urn the pages by clicking b=ll= 1= ======::l 

• Click here to 
on the little turned corner on the bottom le ft; clicking 111m tlw /)(lge 

on the very bottom corne r will turn the pages backwards. • -----83 
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Scrapbook 

84 

·The Scrapbook is a place to permanently hold text or 
: graphics fro m virtually any program; then in any othe r 
• program you can take a copy of it back out from the 
• Scrapbook and paste it into your document. O nce you 
• put something in the Scrapbook it is saved to your disk 
• automatically. The Scrapbook hold s the e ntire object you 
: selected , even though you can ' t always see all of it in the 
• window. 

You must go through the Clipboard to fJUt items 
in the Scrapbook and to take them out. 

· 0 To paste something into the Scrapbook: 
• From your document, select and cofJY the item/ s you 

want to place (this puts a copy on the Clipboard); 

• Open the Scrapbook; 

• Paste the item into the Scrapbook (from the Edit 
menu choose "Paste ")-it will be pasted onto the 
page that is visible, and everything e lse will move 
over one; nothing is being replaced; 

• Close the Scrapbook to get back to your document. 
: 0 To copy an item out of the Scrapbook: 

• Open the Scrapbook 

• Scroll through until the item you want is visible; 

• Copy it (from the Edit menu choose "Copy"); 
• Close the Scrapbook; 

• Go to your document and paste it in (usually any 
text that is pasted in, and sometimes graphics, wi ll 
in sert itse lf wherever the insertion point is flashing; 
in some programs it wi ll just be pasted into the 
middle of the page). 

· 0 To delete an item from the Scrapbook: 

• Scroll through until the item you wanl is visible; 
• From the Edit menu choose "Clear" (Clear removes 

it from the Scrapbook without putting it on the 
Clipboard). 

Scrapbook Document 



TIPS & 
SHORTCUTS 

This is a collection of the tips or important notes that 
are imbedded in the rest of the book, as well as any other 
hints or fasc inating bits of information or shortcuts that 
haven 't been mentioned. Again, nothing is software­
specific; it all relates to the general Mac enviro nment. 
There's an extra page for you to add your own pieces 
of information as you move along with your Mac! 

CHAPTER TWENTY-ONE 

Caps Lock does not act like a typewrite r shift-lock in that · Compendium 
you can still type numbers while Caps Lock is down. p.l8 · of Tips 

To move a window without making it active, press 
the Command key while pressing-and-dragging in its 
title bar. p.20 

To a lign all icons horizontally with no empty spots, 
hold down the Option key while choosing "Clean Up" 
from the Special menu. p .23 

To close all the windows on your Desktop, hold down 
the Option key while clicking in the close box of the 
active window. p.23 

On Systems 6.0 and above, you can also close all the 
windows by pressing Command-Option-W. p.23 

Holding down the Option key while choosing "Quit" 
from any program will close all windows on the 
Desktop before you even get there. p.23 

Holding down the Option key while opening folders 
will make those folders close automatically when 
you return to the Desktop. p.23 

To print the contents of the active window on the 
ImageWri ter, pt-ess Command-Shift-4. p.24 

To print the entire screen on the ImageWriter, press 
Caps Lock down and Command-Shift-4. p.24 

To bring the window belonging to a grey icon to the 
front, simply double-click on it. p.27 

To avoid the dialog/alert box asking if you really want 
to throw away that application, ho ld down the Option 
key while trashing the icon. p.28 

'/he page number 
indica les where mare 

information on that tip 
can be found. 
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• After trashing an icon , "Empty Trash" from the Special 
: men u in orde r to free that space on the disk. p.28 

• To create a MacPaint file (a screen dump) of anything 
: on your screen , press Command-Shift-3. p .28 

• To write notes on a file, use the Get In fo box. p.29 

• Ho ld down the Option key to throw away a locked 
· file. p.30 . 
. Use folders to organize your Desktop and all your 
• di sks as you would your fi ling cabinet. Chapter 9 (p. 31) 

• Create a new folde r a t your Desktop before you begin a 
• project and save all your related parts into that folder, 
• preventing them from getting misplaced . p .33, 64 . 
• To select more than one icon a t a time, press-( in any 
• blanh area)-ancl-cl rag the po inter; a marquee will appear. 
• Anything enclosed in th is marquee will be selected. To 
• move them all at once, press in any blach area (except 
: on the name) and drag; all the outli nes wi ll move 
• simultaneously. p .35 

: Anoth er way to select more than one icon, especially 
• when the icons are not near each other , is to Shift-Click: 
• press the Shift key while clicki ng on icons and every one 
• you click will be selected. Conversely, deselect any by 
• pressing the Shift key-only the ones you click will be 
: deselected from the group. p. 36 

• If you press the Option key while moving an icon from 
: one folder to another, it will move a copy of it. p.36 

· Never hit the Return key while typing un less you 
• really do always wan t the line to end at tha t word. p.40 

• If you are going to center a line, don ' t use tabs or 
• indents or spaces before or after th e line or they will 
: make it appear off-center. p.42 

· While typing, the insertion point picks up the 
· formatting of the characte r to its left-fon t, style, size, 
: align men t, and rule r settings. p .43, 47 

• To remove all the styles a ttached to characters (bold, 
• italic, shadowed, etc.), simply select the text and choose 
: Plai n or Normal. p.43 

• While typing, use the keyboard commands to change 
: the style (to ita lic, bold , e tc.) of the next word/ s to be 



typed ; choose the style again to take it off. This dvoids 
having to select the word/s, pick up the mouse, J1se the 
menu, and set th e insertion point again to contil1ue. p.43 • 

Don ' t forget about Undo! If something happens that 
you didn 't want to happen or don 't like, beforeymt rio 
anything else, even before you scream, UNDO (fro m the 
Edit menu , or Command-Z) . p .46 

Use the Op tion characters to place accent marks over 
letters. p.48 

Use only one space after sentence ends! p.48 

Never use a typeface with a city name on the 
LaserWrite r. p .S0-51 

vVhen saving, be sure to save directly into the folder 
you created to store your work. p.33, 64 

Make several versions of your work using "Save As .. .. " • 
p.65 

If you change your mind about the changes you j ust 
made, close the document and don ' t save those changes; • 
when you reopen it, it will have reve rted back to the last- • 
saved version. p .65 

To avoid wasting paper and toner every time you turn • 
on your LaserWriter , pull the pape r tray o ut a bit before 
you turn it on. p .69 

When ejecting disks at your desktop, rather than 
ejecting them with the menu command it is preferable 
to drag them out through the trash can. This doesn ' t 
destroy any data on the d isk, and removes the memory of • 
that d isk so the computer doesn 't a~k fo r it again. p.73 

If a disk is stuck in the computer after the computer 
has been turned off, hold the mouse button down while 
turning th e machine back on; the disk will po p out. p.74 • 

As a last resort to eject a disk stuck in the computer, 
unroll a paperclip and push it in the tiny hole to the 
right of the drive slo t. T h is will release the mechanism 
and pop the disk ou t. p. 74 

To find a file / documen t/ application that some?ow got 
misplaced but you know it's in there somewhere, use 
Find File from the Apple men u. p.S l 

A FEW EXTRA TIPS 
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A Few ExTRA TIPS 

Real 
Quotation 

Marks! 

•• and~~ 

'and~ 

not 11 and 1 

: Using inch and foot marks in p lace of the real quotation 
• marks is a big problem with so much of the work that is 
• being produced on the Mac. Yes, o n the typewriters we 
• grew up with we used those marks, but we are no longer 
• on typewriters and are not so limited . Also, we are 
• attempting to come close to professional type, and you 
: never see inch and foot marks used as quotation marks 
• in professional type. Unfortunately, they are not located 
• in an obvious spot, so you won 't know they're there 
• unless somebody tells you. So here you are: . 
• To create these beautiful marks in any font (and 
• you 'll always be able to find them in Key Caps), use 
: the following keystrokes: 

" option - [ 

option - shift- [ 

• option-] 

option - shift- ] 

They won't always be 
these big round marks; 
each f ont has its own 
quotes designed for it . 
See the font lists on 
pages 53-57. 

Return Key · Anytime you see a double border around a button (such 
Shortcut · as the one shown below), that means you can press the 

: Return or Enter keys to do that function, instead of 
• picking up the mouse and clicking on it. 

n OK D ( Cancel ) 

Replacing ·When text is highlighted, you don 't need to de lete it 
Highlighted Text · fi rst in order to type in what you want. When text is 

88 

: highlighted, simply type; your typing will replace the 
• highlighted word/ s. This is true anywhere in the Mac-
• all dialog boxes, all programs, even on the Desktop when 
• changing the name of an icon. 

Ellipses ... . Three dots (the ellipsis: ... ) afte r an item in the menu 
in the Menu · means you'll get a dialog box if you choose that item. 

• Anything that doesn't have the ellipsis wi ll just ac tivate 
: as soon as you choose it. 
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In any dialog box that contains boxes for you to fill in , · Tab in 
you can press the Tab key to move you from box to box. . Dialog Boxes 
If there is data already in the box, it will be highlighted 
and anything you type will replace it (you don't have to 
delete it first) ; if there is no data in the box, the Tab key • 
will set the insertion point there, ready for you to type. 

On the front of the Macintosh, if you slip your hand • Dimmer Switch 
right under the rainbow apple, you'll find a little roller 
switch that will dim or brighten your screen . It's a good 
idea to dim the screen if you're going to be away from 
the computer for a length of time, as it's possible to burn • 
an image into the screen, just as on video games. 

There are several varieties of "screen savers" available to • Screen Savers 
help avoid screen bum. A screen saver usually turns the 
screen black and has images that constantly move, like 
shooting stars or geometric shapes or fireworks. As soon • 
as you click the mouse it disappears. Some come as desk • 
accessories that you access through your Apple menu; 
some you put in your System Folder and they automati-
cally come o n after a certain period of time if the keys or • 
mouse haven ' t been touched . Simply clicking the mouse • 
will restore the screen. 

Several of the paint programs allow you to create a • StartupScreen 
StartupScreen. Once you have a StartupScreen installed • 
in your System Folder, every time you boot (start the 
computer) with that System, this image will show on the 
screen for a minute or two. This can be quite fun! To do • 
it, simply create a paint document, or use clip art, and 
save it with the name "StartupScreen." It doesn ' t matter 
what letters are capitalized, but it does have to be one 
word. Put that file into the System Folder. The next time you • 
boot, you 'II see it! • 

· Copying From 
· One Floppy to 

If you need to copy something from one floppy onto 
another floppy but your machine has only one floppy 
drive, this is how to do it: 

• Insert the disk you want to copy onto. While it is 
selected (click once on it if it isn't), from the File 
menu choose "Eject." Remember, this ejects the 
disk but leaves it in RAM (p. 63). You should see 
the grey icon after the disk ejects. 

. Another Floppy 

. with One 

• Insert the disk with the information to be copied 
from. Open it and select the files to copy: press-

· Floppy Drive 
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Rebuilding 
Your Desktop 

and-drag them over to the grey disk (or just drag 
the icon of the entire disk lO the other disk, which 
wi ll replace eve~ylhing). 

• As Mac reads info from one disk and copies it onto 
the other, she will spit out disks and tell you which 
ones to insert next. Just follow the d irections; this is 
called disk-swapping. It will eventually end. 

• If you end up with a grey disk icon on the screen , 
just drag it out through the trash. 

• If you have a hard disk, you may start to notice that it 
• slows down after a few months. This is because there is 
: an invisible fi le that keeps track of all the icons that have 
• ever been seen on your desktop, even if you just loaded 

NOTE: · them on to see what they looked like! There is a way to 

This process will · rebuild your desktop and remove all the unnecessarily­
also destroy the · stored information. Follow these steps: 

WDEF virus! . 
1. Turn off the Mac. 

2. Hold down the Command and Option keys. 

3. Turn the Mac back on, still holding down those 
keys until you see the following dialog box: 

n OK 

Rre you sure you w ont the desktop 
rebuilt on the disk "Hord Disk "? (This 
moy toke o few minutes.) 

)J ( Cancel J 

4. Click OK (or, if you read the tip on the previous 
page, simply hit the Re turn key). 

• Rebuild floppy disk desktop files the same way: 
hold the Command and Option keys d own while 
inserting a disk, unti l you see the above dialog box . 

• Mac will rebuild the desktop file for you and it should 
• now open and close files and folders much faster, plus 
• rid it of the rude and evil WDEF virus. 
: The only problem with rebuilding is that it also destroys 
• any messages you put in your Get Info boxes. Darn it. 
• (See page 29 for info on Get Info .) 

Check Your . To see what fo nts are in th e System while you are still at 
Fonts at the · your Desktop, fro m the Apple menu choose "Key Caps." 

Desktop · At the far riglll of the menu is a new menu item: Key 
: Caps. Press on it to see the list of System fonts. 



AAACK!! 
HELP! 

This list doesn ' t pretend to be an all-inclusive reference 
for every sort of catastrophe that may befall ; rather, it is 
just a compi lation of the most common, simple problems 
one may encounter when first beginning to work on a 
Macintosh. 

If the computer doesn ' t turn on, check all your switches 
(when the switch is labe led 1 or 0, the 1 means On): 

• If you have a floor surge-protector bar with an 
on-off switch on it, it may have been kicked to 
the offposition-make sure it is on. 

• If your hard disk is external , it has its own on-off 
switch that must be turned on jiTst so it can boot 
up; then the Mac must still have its own switch 
turned on also. 

• If your compute r has a fan unit on top with 
buttons to push, those buttons still won ' t ·work 
unless the switch on the back of the compute r 
is also on. The button on the left of the fan unit 
typically star ts the Mac, while the button on the 
right will stan your hard disk (but the hard disk 
itself should be turned on first). 

• If your Mac II starts from the keyboard switch , you 
must make sure the switch on the back of the Mac 
is also on. 

You're trying to start your computer and Mac just spits 
o ut your disk and/ or gives you a big X. This usually 
happens because Mac can't find the System Folder. If 
you are using an external hard disk, make sure the hard 
disk unit itself is turned on, as well as any peripheral 
switches. If you are using a floppy disk, the disk you are 
inserting does not have a System Folder on it. Or it may 
have a System Folder, but the System Folder doesn't 
contain the System icon and/ or the Finder icon. Both 
icons must be on the disk; and actually, both icOJ1S 
must be in the same folder and the folder really must 
be named "System Folder" or confusion may result 
(even on a hard disk). 

CHAPTER TwENTY-Two 

·What To Do If: 

. The Computer 
Doesn't Turn On 

: The Flashing X, 
. or The Disk 
. Gets Spit Out 

·. 
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HELP! 

The Screen Occasionally the computer screen just up and freezes. 
Freezes : The pointer may move around, but you can't click on 

anything and it doesn't respond to the keys. Most often 
this is the result of static electricity. Try unplugging th e 
mouse and/or the keyboard for a minute or two; plug 
it back in and the screen sometimes unfreezes. If th at 
doesn' t work, then you just have to turn the machine 
off. Yes, you wi ll lose everything that hasn 't been saved , 

· which is one of the reasons you should SOS (Save Often , 
· Stupid!. .. e r, Smartie!) . 

Can't Find 
Your Document 

In the beginning you may very often save a document 
· dutifully, but th en when you get to your Desktop you 

Can't Open 
a File 

· can 't find it anywhere. This is because when you saved it 
: you weren ' t paying attention to which disk and/or folder 

you were saving it into. Be sure to read the chapter o n 
Saving (pages 63-65, as well as 33- 34), and carefully 
look at the dialog box pictured there so you understand 
how to save it into the righ t p lace. 

Anyway, at the momen t you can 't find it. Never fear, Mr. 
Find File is here! Read about this guy on page 81-he'll 
go get your file and hand it right over to you. 

When you find your file, put it in a fo lder you have 
created (page 3l ), just as if you were going to put it in 
a fi le folder in the fi ling cabine t. Press-and-drag the fi le 
icon over to the fold er or disk of your choice. T he 
folder/ disk should turn black; when it's black, let go 
and the document will drop right in. 

Sometimes when clicking o n an icon you get a message 
box that te lls you the fi le is locked or in use, or maybe 
that an application couldn 't be found. 

[Iii 14 items 

This symbol indicates the · 
disk is wcked. 

If the disk is locked, you' ll see a li ttle lock symbol in the 
upper left of the window when you open it. When a disk 
is locked you can 't save to it, nor can you p rint from a 
locked System d isk. To unlock it, first eject it. In one of 
the corners is a li ttle b lack tab that covers or uncovers a 
hole. When the ho le is open, the disk is locked (seems 
backwards, doesn ' t it?). So to unlock it, switch the tab 
back so the hole is closed. (More info on page 7.) 
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If the file is locked, click once on it and choose "Get 
Info" from the File menu. In the upper right corner 
th ere is a li ttle box named "Locked" that may be 



checked. If it is checked, then clicking in the box will 
uncheck it and thus unlock the file . 

If the file is in use, then it's in use. Usually you get this 
message if you ll)' to open one of the icons that looks 
like a Macintosh; those are part of the System. 

If it tells you an application can't be found, then one 
of two things is happening: 

• The software application that the document was 
created in is not in the computer. Even though your 
document icon may look like SuperPaint, in orde r to 
view the document it has to go into the application 
SuperPaintto create itse lf. 

• Some files cannot go straight from the Desktop 
to the application, even if the application is in the 
compute r also. In this case, if you know the docu­
ment was created in a certain application and you 
know tha t particular application is in your machine, 
then you must go into the application itself (double­
click on its icon) and open the file you want from 
inside, choosing "Open'" from the File menu. 

When ll)'ing to view clip an, often you will get the 
message that "An application can't be found," even 
when the program it was generated in is on the disk. You 
need to open the actual apj1lication itself, then open each 
individual document through the File menu, choosing 
"Open " (such as YfacPaint, or SuperPaint with the 
MacPaint button selected in the Open box). 

If you are experiencing system bombs too regularly, 
the most common reason is that you have more than 
one System in your computer. One System is essential; 
two Systems is too many. Eve n though you don ' t see 
something call ed System Folder rig ht there on your 
Desktop doesn ' t mean you don't have one tucked away 
in the depths of several other folders somewhere. 

If you have a hard disk, don ' tuse a floppy that also has 
a System on il. If the document you need is on a fl oppy 
with a Syste m Folder, cojJ)' the dowment onto yom· lza1·d disk, 
ejecllhe jlojJ/J)', rmrl &jJen lhe dorummt from the hard disk; you 
can copy the revised file back o nto the floppy when 
you ' re d one. 

HELP! 

· Viewing 
. Clip Art Files 

System Bombs 
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HELP! 

Find any · An easy way to find all the Systems on your hard disk and 
extra Systems · on any floppy disks you are using is to ask Mr. Find File 

(read all about him on page 81). Move them all (except 
one-save the latest version! ) to the Desktop and throw 
them in the u·ash . If you hold down the Option key while 
trashing them, you can avoid th e nice dialog box that 
asks if you're sure you want to do this. You won't be able to 
lhrnw away the System that is booting the machine. 

Understand, though , that each System has its 
own collection of fonts and desk accessories. 
If you have customized a System Folder, save 
that one. 

Text FormaHing 
Unexpectedly 

Changed 

It's not uncommon to open a file on another System 
and find maj or formatting changes. If you created a 
document on your hard disk using the font Palatino, 
then gave a copy of the document on disk to a co-worker 
who ope ned it up and found it had transmogrified itself 
into the font Helvetica, meaning all your formatting 

94 

Printing 
Doesn't Work 

· was thrown off, that's because Palatino was not in the 
co-worker's System. If the document can't find the font 
it was specified in, then it has to choose another from 
what is available. The only solution is to make sure both 
Systems have the same information in their System 
Folder and font fi les . 

. This may happen occasionally even if the fonts are the 
same in both Systems. Another possible reason for this 
is that some programs create a fi le in the System Folder 
that ho lds the formatting for the document. When you 
open up the document with a diffe ren·. System Folder, it 
can't find its formatting. If you know you are going to be 
taking that document to another computer, as soon as 

· you quit creati ng it, go into the System Folder and find 
· the formatting file; e.g. Word Settings if you are using 

Microsoft Word. Renam e that fi le to correspond with the 
file you just created (though not exactly the same name), 
and put them both in the same folder. 

• One of the most common reasons why printing won ' t 
work is because the appropriate printer icon wasn' t 
chosen. Go to Chooser from the Apple menu and 
choose your printer (see pages 68 and 79). 



• Make sure the printer is on , that it has paper, and 
that the paper tray, if there is one, is firm ly attached. 

• Make sure any networking cables are conn ected . 

• On an Image Writer, make sure the Select light is on. 
It must be on in order to print. 

• Also on an Image Writer make sure the lever on the 
hand roller corresponds to the way you are feeding 
paper-that is, friction-feed for single sheets (that's 
the symbol with two rolle rs, towards the back); and 
pin-feed for pin-fed labels and paper (that's the 
symbol with one roller and little pins, pulled towards 
the front). 

• If the disk that the System J;older is on has less than 
about 15K available, Mac can not print. She needs 
some free space to send over the messages for 
printing. Yo u will have to free up some space on 
that disk by removing a fi le or two. 

• Sometimes gremlins prevent printing properly. If 
you have checked everything and there really seems 
to be no logical reason for it not to print, go away for 
a while, let someone else print to that printer , shut 
down, come back later, try again. This sometimes 
works. One never knows. 

• Unusual printing problems are a common symptom 
of a virus attack. There is a great deal of literature 
available on the topic of viruses; check with your 
compute r dealer for information and for tl1e software 
avai lable for detection and eradication. If you think 
you have the WDEF virus, read about rebuilding your 
Desktop to destroy it, page 90. 

If you want to form-feed or line-feed the paper, the 
Select light must be off. Be sure to turn it back on again 
before you try to print! 

Notice that th e line-feed button will feed the paper 
through one line at a time for four lines, then it turns 
into a controllable form-feed; as soon as you let go it 
stops. Form-feed itself will roll through an entire page 
length (generally II inches). 

HELP! 

Can't Form-Feed 
or Line-Feed the 
Image Writer 
Paper 
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HELP! 

There's Garbage 
Hanging Around 

Outside the 
Trash Can 

If garbage piles up around your can , it's because you 
didn ' t put it inside the can , but set it down outside, just 
like the kids. Whe n the very tip of the pointer touches the 
can and turns it black, that's the time to le t go. It doesn' t 
matter if the icon itself is positioned over the can- it's 
the pointer tip that opens the lid. 

Grey Disk Icon is · A grey disk icon can mean one of two things, either it is 
Left on the Screen · open or it is in RAM. 

liJ.,li.~,l~=.,,=.~ ',,=.lll,l'~, :~:.;~~~ ;~:~r;s .::=:"; ,::;.: ~::t:~~~~:.;~~::~r;er 
clicked on it and its window is open somewhere on 

Grey dish icon left on the . the screen. If you can ' t see it because the re a re o ther 
screen after being ejected · windows in the way, simply double-dick on the grey 
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· shadow and it will come forth as the active window. 

· If the disk itself is not in the floppy drive, then you most 
like ly ejected that disk by choosing "Eject" from the File 
menu or by pressing Command-E. This procedure does 
eject the disk, but a lso leaves its information in Mac's 
memory. Read page 73 for a thorough explanation of 

. what happe ned and how to avoid it. 



Use these pages to record any new tips or 
shortcuts or troubleshooting techniques you 
happen to discover or read about. 

YouR TIPS 
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More of your : 
own tips . 



Accent marks, 48 Close Viewing fonts from, 90 
Active Window, 19-20, 21 Box, 19,21 Dialog boxes, 16 
Alarm Clock, 77-78 Documents, 71 Fonl/DA Mover, 60-1 
Alert box, avoiding, 28 Windows, 19, 21,75 Save As ... , 16, 33-4 
Alignment, 44 All windows, 23, 75 Ope n, 38 
Apostrophes, 52, 88 Close box, 19, 21 Print, 68-9 
"Application can't be Command key, 16-1 8,46 Rebuilding, 90 

found," 93 Typing 3€, 104 Dimme r switch, 89 
Application icons, 26 Computer paper, 69 Disk icons, 25 
Applications, 37, 26 Control key, 18 Grey, 73,96 

Trashing, 27, 28 Control Panel, 79-81 Disks, 6 
Avant Garde, 50, 57 Copy,35,36, 44,45,89 Backup, 8 
Backspace, 17, 39 Alarm Clock, 77 Capacity of, 6, 7, 21 

re: Clipboard, 46 Calculator, 78 Caring for, 6 
Backspace key, 17, 39 Duplicate, 36 Ejecting, 73-4 
Backup disks, 8 Files, 35 Floppy, 6, 21 
Bit-mapped fon ts, 49-55 Floppy-to-floppy, 89 Grey, 25, 73, 96 
Bits, 5 Folders, 32, 35 l-Iard disks, 7, 21 
Blank space in text, 41 Keyboard shortcut, 46 Icons, 25 
Bomb, 93 More than one fi le, 35 Initializing, 6 
Bookman, 50, 57 Onto same disk, 36 Inserting, 10 
Boot up, 9, 10 With Scrapbook, 84 Locked, 7,92 
Bytes, 5 Control key, 18 Rebuilding Desktop, 90 
Calculator, 78 Courier, 49, 50, 56 Renaming, 30 
Calendar, 77-8 Cut, 44, 45, 84 Unlock, 7, 92 

Clock, 77-8, 80 Keyboard shortcut, 46 Document, 14 
Comrol Panel, 80 DAs (see Desk Accessories) Icons, 26 

Caps Lock, 18 Delete, 17, 39 Can't find, 92 
Cente ring text, 42 re: Clipboard, 46 Can't open, 92 
Chicago, 49, 53 Delete key, 17, 39 Find ing, 81-2, 92 
Chooser, 68, 79 Deselecting fi les, 36 Get Info, 29 
City-named fonts, 49-57 Deselecting text, 40 Lock,30 
Clean Up Window, 23 Desk Accessories, 77-84 New vs. Open, 38 
Click (see also Icons) Alarm Clock, 77-8 Opening, 26, 37 

and-drag, 13 Calculator, 78 Size of, 22, 29 
Double, 13, 40 Chooser, 68, 79 Unlock, 30 
Hot spot, 14 Control Panel, 79-81 Double-clicking, 13, 40 
In the scroll bar, 21 Find File, 81-2 Text, 40 
Press, 13 Font/ DA Mover, 59-62 Icons, 25-28 
Press-and-drag, 13 Key Caps, 47-8, 82-3 Downloadable fonts, 62 
Single , 13 Scrapbook, 84 Drag, 13,40 

Clip art, viewing, 93 Desktop, 10, 11 Drive 
Clipboard, 44-45 Changing the pattern, 80 Exte rnal, 10 
Clock Menu, 15, 71 l-Iard , 7, 9 

Alarm, 77-8, 80 Organizing, 11 , 12 Internal, 10 
Comrol Panel, 80 Rebui lding, 90 Duplicate fi les, 36 
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[jcct, 73-4 City-named, 49-5 1 Grey, 27, 73, 96 
Floppy to copy, 89 Cut & Copy, 44, 45 Highl ighted, 27 
From dialog boxes, 74 Downloadable, 62 Locking fi le, 30, 92 
From keyboard, 73 Family, 62 Moving, 30, 35, 36 
From me nu, 73 Highlight text, 20, 21 Naming, 30 
Shut Down , 71,73 ImageWriter, 49-55 Open, 27 
Through trash, 73 Important info, 50-1 Printer, 26 
With mouse, 74 Interesting info, 49 Removing, 27 
With paperclip, 74 LaserWriter, 49-52, 56-8 Renaming, 30 

Ellipses, 16, 88 Moving, 52, 59 Screen dump, 28 
Empty trash , 27 Paste, 45, 46 Selected, 27 
En ter key, 18 PostScript, 49-52, 56-8 Software, 26 
Escape key (esc), 17, 18 Printer fonts, 52 System, 25 
Extended keyboard, 17 Printers, 49 Trash can , 27, 73 
External drive, I 0 Screen fonts, 52, 59 Undo name change, 30 
File (also see Document, Sizes, 5 1 View by, 22 

Application ) Special char 's, 46-7, I 04 ImageWriter. 67, 68 
Get Info, 29 Standard, 49-50 Chooser, 68 
Find File, 8 1, 82 Traditional, 49 Fonts, 49-51, 53-5 
In Use, 93 View from Desktop, 90 leon, 68 
Locked,30,92 Where they reside, 59 Paper feeding, 70 
Renaming, 25, 30, 31 Form-feed , 70 Printing to, 68, 69 
Unlock, 30, 92 From/ To, 69 Information bar, 21 

Find File, 81 , 82 Frozen screen, 91 Inserting a d isk, 10 
Finder, 9, 10, 11 Geneva, 49, 50, 53-5 Insertion point, 39, 43, 47-8 
Finder icon , 9 Get Info, 29 Internal drive, 10 
Floppy d isks (see Disks) Greyicons,20,27, 73 Key Caps, 47-8, 82-3 
Folders, 25, 31 Grey d isk icon , 73, 96 Keyboard, 17 

Copying, 32 Grey scroll bar, 19, 20, 21 Backspace key, 17,39 
Creating, 31 Hard copy, 67 Caps Lock, 18 
Icons, 25, 31 Hard disk, 7 Command key, 16, 46 
Information, 19, 21,29 in ternal, external, 9 Control key, 18 
Naming, renaming, 3 I Hard return , 40 Control panel, 80 
Open ing, 32 Help, 9 1-8 De lay unti l re peat, 80 
O rganizing with, 32 Helvetica, 49-51, 55-8 De lete key, I 7, 39 
Put something inside, 32 Hierarchal file syste m, 32 Enter key, 18 
Remove something, 32 Highligh t text, 40-2, 88 Escape key, 17 
Saving imo, 33, 34 To unhighlight, 40, 88 Extended, 17 
Trashing, 27 Highligh ted icons, 27 Key repeat rate, 80 

Font/ DA Mover, 59-62 Hot spot, 14 Option key, 18 
Fonts, 49-58, 62 !-Beam, 39 Return key, 18 

Accent marks, 48, I 04 Icons, 25 Shift key, 18 
Bit-mapped, 49-55 Application, 26 Shortcuts, 16, 46 
Changing, 42 Black, 27 Spacebar, 18 
Changing al ignment, 44 Copy, 35,36 Standard, 17 
Changing style, 43 Disk, 25 Tilde key(-), 17 
Changi ng style from Document, 26 Keyboard shortcuts, 16, 46 

the keyboard, 43 Duplicate. 36 Ki lobytes, 5, 2 I 
Changing type size, 43 Folder, 25 Ks,5, 21 
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LaserWriter, 48, 50-2, 56-8, 
68 

Saving toner & paper, 68 
Line-feed, 70 
Line up pin-fed paper, 70 
Linotronic, 67 
Locked d isk, 7, 92 
Locked file, 29 
Marquee, 35 
Megabytes, 7, 2 1 
Megs, 5 
Memory, 63 
Menu, 15 

Choosing commands, 15 
Desktop, 71 
Ellipses in , 16 
Greyvs. black items, 15 
Keyboard shortcu ts, 16 
Pull-down, 15 
Pop-out, 16 

Monaco, 49, 50, 53-5 
Mouse, 13, 81 

Cleaning, 14 
Double-dick, 13 
Pointer, 14 
Press-and-drag, 13 
Press, 13 
Single-click, 13 
Speed control, 81 

Name icons, 30-1 
Files/ folders, disks, 30-1 

New ... , 38 
New Century Schlbk, 50, 57 
New vs. Open , 38 
New York, 49-55 
Note Pad, 83 
Open ... , 38 
Open dialog box, 38 
Open icons, 27 
Open vs. New, 38 
Opening 

Applications, 26, 37, 38 
Documents, 26, 37, 38 

Option key, 17 
Accent marks, 48 
Alert box, 28 
Closing all windows, 23 
Duplicating, 36 
Quitting, 23 

Organize, l l , 12, 32 
Orientation, 69 
Palatino, 50, 56 
Paper 

Computer pape r, 
Lining up pin-fed , 70 
Saving LaserWri ter, 69 

Paste, 45 
Keyboard shortcut, 46 

Pe riods, o ne space, 48 
Pin-fed paper, 70 
Pixe l, 43 
Pointer, 14 
Pop-out menus, 15 
Port, 79 
Power User, 23 
Press, 13 
Press-and-drag, 13 
Print (also see Fonts) 67-9 

Dialog box, 68-9 
Doesn ' t work, 94 
Screen, 24 
To ImageWriter, 67, 68, 70 
To LaserWri ter, 67 
To Lino tronic, 67 
Window, 24 

Print Window, 24 
Print Screen, 24 
Printer icons, 26 
Printers (see ImageWriter , 

LaserWriter, Linotronic) 
Programs, 37 
Pull-down menu, 15 
Put Away, 27, 82 
Quality, 68-9 
Quit, 7 1 
RAM, 45,63 
Random Access Memory, 63 
Re building the Desktop, 90 
Reduced size, 69 
Remove fonts o r DAs, 59-61 
Rename icons, 31 
Return Key, 18, 40 

Double-space, 41 
Hard return, 40 
Removing a return, 4 1 
Word wrap, 40 

Revert, 65 
Rule # 1, 63 

INDEX 

Rule #2, 42 
Rule #3, 8 
Save, 33, 34, 63-5 

SOS, 63 
Save As ... , 33, 64 

Dialog box, 33-4, 64 
Diffe rent versio n, 65 
Into your folder, 33-4 
Mini-menu in , 34, 64 
Onto your d isk, 34, 64 
Onto another disk, 64 
Reverting, 65 

Scrapbook, 84 
Screen 

Cha nging pattern, 80 
Desktop, 10, I I 
Dimmer switch, 89 
Frozen, 91 

Printing, 24 
Screen savers, 89 
StartUpScreen, 89 
Screen dump, 28 
Scroll arrows, 19, 20 
Scroll box, 19,21 
Scrolling, 20 
Select first, then operate , 42 
Selecting 

Blank space, 41 
Icons, 25-7 
With marquee, 35 
More than one icon , 35 
Rule #2, 42 
Shift-clicking, 36 
Text, 40-2 

Service bureau, 67 
Shift-cl ick, 36 
Shift key, 18 
Shortcuts (see Keyboard) 
Shut Down, 7 1, 73 
Size box, 19, 20 
Software, 26, 37 

(also see Application ) 
SOS, 63 
Sound,80 
Spacebar, 18 
Specia l characters, 46-8 
Special menu , 75 
SLandard keyboard, I 7 
SLarting up, 9 
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Start-up disk, 10 
StanUpScrcen, 89 
Style , changing, 43 
Symbol font , 49, 56 
System, 9, 10 
Syste m bombs, 93 
System Folder, 9 
System icons, 9, 25 
System versions, 10 
Tab key in d ialog boxes, 89 
Tall Adjusted , 53, 69 
Text (see Fonts, Typing) 
Tilde key(-), 17 
T imes, 49-52, 56, 58 
Tips, 85-90 

Compendium, 85 
Dimme r switch, 89 
Ellipses in menu, 88 
Quotation marks, 88 
Re building desktop, 89 
Re turn key shortcut, 88 
Screen savers, 89 
StartUpScreen, 89 
Tab in d ialog boxes, 89 

Title bar, 19 
Toggle switch, 43 
Toner saver, 68 
Trash can, 27 

Ejecting disks, 73, 
Put Away, 27 
Removing fi les, 27 
With Option key, 28 

Colophon 
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Turning it on, 9 
Typing, 39-48 
Undo, 46 

Keyboard shortcut, 24 
Unlock, 7, 30, 92 
Variations of a doc't, 65 
Venice, 49, 50, 53-5 
Viewing the window, 21-2 
Virus, 90, 95 
vVDEF virus, 90 
White scroll bar, 19, 20 
Windows, 19-24 

Active window, 23 
Clean up, 23 
Close all, 23 
Close box, 21 
Grey scroll bar, 20 
Icon, 19, 25 
Organizing, 3 1, 150 
Print active window, 24 
Print all windows, 24 
Scroll arrows, 20 
Scroll box, 21 
Title bar, 19 
Viewing, 22 
White scro ll bar, 12, 13 
Zoom box, 19, 20 

Word wrap, 40 
Zapf Chancery, 50, 57 
Zapf Dingbats, 50, 57, 103 
Zoom box, 19, 20 

This book was produced on a Mac SE with a 20 meg 
internal hard disk, Claris Mac Write II for word processing, 
Silicon Beach's SuperPaint for cleaning up the screen 
dumps, Aldus Pagemaker 3.02 fo r the page design and 
layout (tha nk goodness for style sheets!), an Apple Laser­
Writer for proofing, and a Linotronic fo r final output to 
go to press. 

The fon ts are the 1TC New Baskerville and the Futura 
fa milies, both from Adobe Systems Incorporated. 



Text Zapf Shift Option Shift & Za~f Dingbats Option 
~ ;;...- ® , In lhe chart to the left, find the Zapf Dingbat 

2 ~ + • -~ you wish to type. Hold down the Shift, the 

3 ./ ~ • _. Option , or the Shift-and-Option keys while . 
4 v ~ • -· pressing the text character. The dingbat in 

• 
5 X '8' ® --+ 

the Zapf column needs no exu·a keys. 

6 • ~ • -
7 X ({) ~ .. 
8 )( ... • !T n (outlined) 0 Sh- ] " 
9 + + (i) - Sh- - " (outlined) 0 
0 <{? r;:: 8 );>- Sh- [ i 

{b " fj (l) t (outlined) v Sh- \ ' 
= t .... ® ® s (outlined) 6 
q 0 * 0 0 u (outlined) 0 
w • * @ )> 

Opt-6 (outlined) c::? 
e * .;. ~ >-
r 0 * + .. 

'Y * 
,. 

Opt-Sh-/ CD Q) 
y I • ® • Opr-u-spac<.: 

u • * <D • Opr-1 @ Opt-= @ 

* i::l ltl c:> 
Opr-1 ® Opt-Sh-' ® 

0 0 * ® @ 

p 0 -c( 0 ~ Opt-v @ Opt-Sh-o @ 

[ ::: i 0 @ @ ® Opt-f Opr-5 
l * " -+ --? 

a 0 ¢ I ) Opt-x @ Opt-Sh-= ® 
s ... * ~-- <> (J) ® 
d * + 0 Q 

Opt-j Opt-, 

f ... ,:,: .. + ® 0 Opt-\ ® Opt-. ® 
g ;tE <0- • 0 

Opt-Sh-\ ® Opt-y @ 
h * * -) 0 

j ... 
';.: ; 0 (f) 0 Opt-; (@ Opt-m ® 

k * * •• 
• * Q) 0 

+ + ®l ~ Opt-d 0 Opt-Spcbar 0 
@ }< g) @ 

z I • G) •• Opt-w @ Opt-· then Sh-a @ 

X * ® " Opr-Sh-p @ Opt-n then Sh-a €) 
c * 

. I ( 

v ·:· * @) t Opr-p 0 Opt-n then Sh-o 0 
b 0 + 0 Opt-b @ Opt-Sh-q 0 
n • * " 

.,. 
m 0 * @ .... Opt-q 0 Opt-q 0 

~ ~ (f) Jt+ 
Opt-0 8 Opt-- fj 

~ 'i? @ .. 
I @ t ' . (j) Opt-z G) Opt-Sh-- (l) 

rS'J " rS'J - @ Opt-[ 0 Opt-' 
spacebar 0 0 
\ * ' ® ® Opt-o @ Opt-Sh-[ (ID 



A HANDY CHART 

Here is " Option- [ Opening double quote 

a handy chart " Option -Shift- [ Closing double quote 
for finding 

' Option-] Opening single quote 
some of the 

special characters . 
, Option- Shift-] Closing single quote; 

available that . Apostrophe 

will make your . Hyphen Hyphen 
work look more Option - Hyphen En dash 

professional 
Option- Shift- Hyphen Em dash 

Option-; Ellipsis (this character 
cannot be separated at the 
end of a line as the three 
periods can) 

• Option -8 Bullet 

0 0 (in font Zapf Dingbats) 

• n (in font Zapf Dingbats) 

D n (outlined) (in font Zapf Dingbats) 

© Option -g Copyright symbol 
TM Option- 2 Trademark symbol 

® Option- r Registration symbol 
0 Option -Shift- 8 Degree symbol: 105° F 

¢ Option-$ Cents symbol 

I Option -Shift - ! Fraction bar (it doesn 't 
descend below the base-
line as the slash does) 

fi Option -Shift- 5 Ligature for f and i 

fl Option - Shift - 6 Ligature for f and I 

£ Option- 3 English pound sign 

( Option -Shift-? Spanish symbol 

~ Option- c Cedilla, lowercase 

c Option- Shift- c Cedilla, capital 

3€ Control -Q (only in tl1e Chicago font; 
the Control key is not on 
a Mac Plus keyboard) 

Accent Marks Option - e 

Refer to page 48 to learn · Option--
how to type these in; · Option- u 
this page is merely a · 

Option- n quick reference · 
1\ Option- i 
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T H E L I T T L E 

M B 0 0 K 

A N INFORMAL G U I D E 

Here is your handy reference to the Macintosh, loaded with 

hundreds of useful tips, shortcuts, and troubleshooting techniques: 

• Orientation: The "unwriHen rules" that govern the Mac's 
system of menus, icons, and windows. 

• Time Savers: Dozens of mouse and keyboard shortcuts. 
• Working Smart: How to organize your folders, files, fonts, 

programs, and desk accessories. 
• Looking Good in Print: Essential tips on typography and 

font selection. 
• Handy Tools: How to use the Font/DA Mover and desk 

accessories like the Control Panel to customize your system. 
• Help! What to do when you don't know w hat to do. 

"I recommend The Little Mac Book to everyone walking in the 
door for training-read this book firs t!" 

-Harry Critchfield, Training Coordinator 
SMUG (Berkeley Macintosh User Gtoup) 

"The Little Mac Book is accessible, interesting, to the point, 
organized the way my mind works, simple enough for me to 
grasp-and clear enough to understand. This book thinks like 
the Moe does and like I do." 

-Jan V. White, designer/author 
Graphic Design for the Electronic Age 

I SB N 0-938151 - 21-S 
Peechpit Press 
1085 Keith Ave. 
Berkeley, CA 94708 
800 283·94l4 51295 
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